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Chapter 1 Getting Started
Getting Started

This chapter lists system requirements for the LucidShape family of products and tells you how to contact
LucidShape Customer Support.

Although the examples in this document show and refer to the LucidShape product, the instructions apply
to the entire LucidShape family of products, which includes:

• LucidShape

• LucidDrive

• LucidShape CAA V5 Based product and the separately licensed Base Module, Visualize Module, and
Light Guide Design Module

In this section:

System Requirements on page 5
Before installing LucidShape, confirm you meet the system requirements.

Licensing Requirements on page 7
Before you install your LucidShape family product, you need to confirm your licensing.

Contacting LucidShape Customer Support on page 9
Need expert help using our software?

System Requirements
Before installing LucidShape, confirm you meet the system requirements.

• You must have a license for the product. See Licensing Requirements on page 7 for details.

• A personal computer with any CPU with at least four cores from the last or second-to-last processor
generation.

To get maximum performance from multi-threaded simulations, we recommend four or more CPU
cores. LucidShape simulations make use of multi-threading, and a high number of cores or threads will
enhance ray tracing speed; however, the most beneficial feature to take into consideration is a CPU
with a very high single-thread frequency (or single-thread performance).

If Intel Hyper-Threading Technology is available on your computer, enabling it will further increase
multi-threaded simulation performance.

• Operating System:

• LucidShape - Windows 10 64-bit

• LucidDrive - Windows 10 64-bit

• LucidShape CAA V5 Based for CATIA R27, R28, R29, R30, R31, and R32 - Windows 10 64-bit

• Random Access Memory (RAM): 8 GB minimum, 16 GB or more recommended.

If you are planning on running any of the following scenarios, 32 GB or more recommended:

• spectral simulations with high sensor resolutions
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• simulations using multi-view luminance camera sensors

• simulations with many sensors in the model

• models that contain complex geometry

• GPU:

• With GPUTrace: Any NVIDIA graphics card with a CUDA compute capability of at least 5.0 can
be used. We recommend using the latest NVIDIA graphics card driver available for your specific
GPU card. The driver version number must be at least 455. If these requirements are not met, the
software can freeze when you use GPUTrace, and you could lose any unsaved work.

• Without GPUTrace: LucidShape does not require a special graphics card. If you are installing
LucidShape CAA V5 Based, see the Certified Workstations link on the Dassault Systemes
Hardware and Software (https://www.3ds.com/support/certified-hardware/) page.

• LucidDrive: Any NVIDIA graphics card with the latest available graphics card driver (with
a CUDA compute capability of at least 5.0). GeForce strongly recommended (there might be
performance issues with Quadro cards due to driver problems).

If you are purchasing graphics cards, contact LucidShape Customer Support for the latest
recommendations.

• Free disk space as listed to install the LucidShape product:

Product Disk Space

LucidShape 2.0 GB

LucidDrive 2.0 GB

LucidShape CAA V5 Based 2.0 GB

• Free disk space on the system drive (i.e., the drive on which the operating system is installed) for
installing prerequisite software and for processes and temporary files required when running the
product: 5 GB. If LucidShape is installed on a drive other than the system drive, that drive should also
have at least 5 GB free disk space.

Large models and complex analyses may require significantly more disk space.

• Display:

• A high-resolution monitor (1280 x 1024 or better) with 16-bit (65536) colors or more.

• An OpenGL compliant graphics card with stable ICD driver support recommended. We
recommend that you always use the latest version of the driver for your graphics card.

• If you are installing the LucidShape CAA V5 Based product, you must have a licensed version of a
supported CATIA V5 release and the CATIA Mechanical Design 2 Configuration (MD2).

The Design Module, Visualize Module, Light Guide Design Module, and SmartStart Material Library
Module for the LucidShape CAA V5 Based product each requires a separate license.

Note:  CATIA licensing requirements for the LucidShape CAA Light Guide Design Module are
subject to change in future releases. To check for updates to these requirements, contact LucidShape
Customer Support.

• A DVD drive, if installing from a DVD.
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Licensing Requirements
Before you install your LucidShape family product, you need to confirm your licensing.

LucidShape provides two methods for licensing:

• LucidShape Legacy Licensing — Used in releases up to and including LucidDrive 2023.03. Customers
who are updating from a previous version of LucidShape should continue to use Legacy Licensing
unless instructed otherwise by a Synopsys Optical Solutions representative (or your local application
license administrator). Legacy Licensing is the default installation choice.

• Synopsys Common Licensing — This method of licensing is available for new customers beginning
with LucidDrive 2023.03. You will be instructed by a Synopsys Optical Solutions representative (or
your local application license administrator) whether to use Synopsys Common Licensing. During
installation, you must select Synopsys Common Licensing to install it.

Your LucidShape or IT Administrator should have provided you with information about which licensing
method to choose.

If you are the LucidShape or IT Administrator, you should be contacted by your Optical Solutions
representative or local distributor regarding your licensing. If you are still unsure, you can use the Help
me choose buttons in the installer or go to https://www.synopsys.com/optical-solutions/support/choosing-
license-option.html.

To install LucidShape with either of these licensing methods, you must have license keys provided by
Synopsys Optical Solutions via SolvNetPlus SmartKeys or your local LucidShape software distributor.

Note:  Host IDs and license keys are unique to each method of licensing and are not interchangeable.

In this section:

LucidShape Legacy Licensing on page 7
This method of licensing is used in releases up to and including LucidShape 2023.03.

Synopsys Common Licensing on page 8
The 2023.03 version of the LucidShape family of products is the first release that can support Host IDs
compatible with Synopsys Common Licensing.

LucidShape Legacy Licensing
This method of licensing is used in releases up to and including LucidShape 2023.03.

Unless you are informed otherwise by your Optical Solutions representative (or your local LucidShape
administrator), use this default licensing type when updating your LucidShape application.

You can run LucidShape products with Legacy Licensing using either a fixed license or a floating license.

• A fixed license allows you to run LucidShape only on the computer on which it is installed.

For configuration details, see Configuring LucidShape with a Fixed License on page 13.

• A floating license, which is installed on a network server, allows you to run LucidShape on any
computer on the same network.

The number of users that can use LucidShape concurrently is limited by the licensing software.

For configuration details, see Configuring LucidShape with a Floating License on page 16.
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For information on how to set up the OSG Floating License Manager, see Installing and Managing the
OSG Floating License Manager (Legacy Licensing) on page 19.

If you are installing LucidShape using Legacy Licensing, you need the following:

• License keys provided by Synopsys OSG via SolvNetPlus SmartKeys or your local LucidShape
software distributor.

• If you are using a fixed license or are installing OSG Floating License Manager, a license dongle and a
USB2.0 (or higher) port (using a USB Type A socket).

• If you will be running LucidShape with a floating license, you must also have:

• TCP/IP network protocol

• The host name of the OSG Floating License Manager.

Before installing LucidShape, your LucidShape or IT Administrator should install and configure
the OSG Floating License Manager (a Sentinel RMS license manager that has been customized
for Synopsys OSG software), provided by Synopsys OSG via SolvNetPlus. See Installing and
Managing the OSG Floating License Manager (Legacy Licensing) on page 19 for instructions.

Synopsys Common Licensing
The 2023.03 version of the LucidShape family of products is the first release that can support Host IDs
compatible with Synopsys Common Licensing.

With Synopsys Common Licensing, you can run LucidShape using either a nodelocked license or network
license.

• A nodelocked license allows you to run LucidShape only on the computer on which it is installed.

• A network license, which is installed on a network server, allows you to run LucidShape on any
computer on the same network.

The number of users that can use LucidShape concurrently is limited by the licensing software.

Note:  The LucidShape installer includes and automates the Synopsys Common Licensing server
installation. If you already use Synopsys Common Licensing in your organization, contact LucidShape
Customer Support before installation.

The LucidShape installer installs both LucidShape and the required Synopsys Common Licensing
components. The installation process differs depending on the intended use of your system:

• When you install LucidShape with a Nodelocked license, the license is installed to the system, rather
than having it managed by a Synopsys Common Licensing server. A nodelocked license allows you to
run LucidShape only on the system on which it is installed.

• When you install LucidShape with a Network (Client Installation) license, the license is managed by a
Synopsys Common Licensing server.

If you will be running LucidShape with a network license, you must also have:

• TCP/IP network protocol

• The port and server name of the system running the Synopsys Common Licensing server.

• The client systems and the server system must be on the same network.
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• When you install LucidShape with a Network (Server Installation), you are installing the Synopsys
Common Licensing server. The Synopsys Common Licensing license administrator uses this system to
manage licensing for the site. A site may have more than one license server. The system must:

• be on the same network as the network clients running LucidShape.

• use the TCP/IP network protocol.

While the LucidShape application is installed to this system, it does not use a network license unless
you run LucidShape on that system.

If you will be running LucidShape with a nodelocked license or the network (Server) license, you may
need a USB dongle acquired by you or your site’s license administrator from your local Synopsys Sales
Representative. Your LucidShape or IT Administrator should inform you if one is required. If you are the
LucidShape or IT Administrator, contact your LucidShape representative. If you do require a dongle, you
need the dongle and a USB2.0 (or higher) port (using a USB Type A socket).

If you are the LucidShape license administrator or IT administrator who will install the Synopsys Common
Licensing server, see also Selecting a Synopsys Common Licensing License Server on page 45.

Contacting LucidShape Customer Support
Need expert help using our software?

• Open a support ticket in SolvNetPlus. Learn more about how to access and use SolvNetPlus.

• Email lucidshape_support@synopsys.com.

• The SolvNetPlus Knowledge Base features a collection of searchable technical articles, example files,
macros, release notes, FAQs, and more, available at any time. First log into SolvNetPlus, then go to the
Collection of Optical and Photonic Solutions Knowledge Article.

• Visit our main Support page for an overview of how to access product learning, self-help, and other
resources.

• Visit our Licensing and Installation Help page.

• View our list of global support contacts.
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Chapter 2 Installing LucidShape with Legacy
Licensing
Installing LucidShape with Legacy Licensing

You can run LucidShape products using either a fixed license or a floating license.

• If you are using a fixed license, you also need a USB license dongle.

• If you are using a floating license, you need the name of your license server.

Before installing LucidShape, your LucidShape or IT Administrator should install and configure the
OSG Floating License Manager.

These instructions assume that you have already downloaded LucidShape from the Synopsys SolvNetPlus
website or that you ordered and received a LucidShape DVD. If you have not done so, see Using
SolvNetPlus to Obtain LucidShape Software and Licenses on page 51.

Note:  Except where noted, the instructions and illustrations in this document for the LucidShape product
apply to all of the LucidShape products.

For instructions on installing LucidShape usingSynopsys Common Licensing, see Installing LucidShape
with Synopsys Common Licensing on page 37.

In this section:

Installing LucidShape on page 10
Follow these instructions to install LucidShape on your system using the Legacy Licensing method.

Configuring LucidShape with a Fixed License on page 13
After installing LucidShape with Legacy Licensing, you must configure the license key file.

Configuring LucidShape with a Floating License on page 16
If you are using a floating license, you need to provide the name of the server hosting the OSG
Floating License Manager. Your LucidShape or IT Administrator should have provided you with the
name of the server hosting the OSG Floating License Manager.

Installing LucidShape
Follow these instructions to install LucidShape on your system using the Legacy Licensing method.

1. Log on to your computer as Administrator.

2. Navigate to the folder where the LucidShape setup file is located. If you have a DVD, insert it into the
DVD drive and navigate to that drive.

3. Double-click the setup file (e.g., SetupLucidShape_version.exe)

where version is the version number for the release (e.g., SetupLucidShape_2022.03.exe).
For the LucidShape CAA V5 Based product, the file name also includes the CATIA version (e.g.,
SetupLucidShapeCAA_R32_2022.06-1.exe).

The Setup window is displayed at the License Agreement screen.
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4. Click I Agree to continue.

The Choose Install Location screen is displayed.

5. Specify a location.

If an earlier release of the product was installed, the default location will be set to the path used for that
release. If you want to install the program in a different folder, click the Browse button to locate and
specify that folder.

For most LucidShape products, the default location is C:\productName_version.

For LucidShape CAA, the default location is C:\Program Files\Synopsys
\LucidShapeCAA\CATIAversion\LucidShapeCAAversion.

6. After selecting a Destination folder, click Next.
The License Installation Options screen is displayed.

These instructions are for the Legacy Licensing installation. If you need to use Synopsys Common
Licensing, see Installing LucidShape with Synopsys Common Licensing on page 37.

7. Click Next (for LucidShape CAA V5 Based) or click Install (for all other LucidShape products).

If you are installing a LucidShape product other than LucidShape CAA V5 Based, the Setup window
shows the progress of the installation. Skip to step 12 on page 12 to finish the installation process.

If you are installing the LucidShape CAA V5 Based product, the Choose CATIA Installation Directory
screen is displayed; continue with the following steps.

The Choose CATIA Installation Directory screen allows you to associate the LucidShape CAA product
with a specific CATIA installation. If a CATIA installation folder was detected, the path to that folder
is displayed in the input field. If CATIA is not installed on the same computer, or if CATIA is managed
by a third-party tool that maintains configurations and versions, the input field may be blank, and
you may need to perform additional steps to complete your installation. See Troubleshooting the
LucidShape CAA V5 Based Installation on page 63 for details.
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8. If you need to specify or want to change the CATIA installation folder, edit the path or click the
Browse button to navigate to it and select it.

9. Click Next to continue.

The Choose Public Data Location screen is displayed. This allows you to specify a location for
installing public data, such as example model files. To allow interactive use of these files, choose
a folder for which you have write permission. The default location is C:\Users\Public
\Documents\LucidShapeCAA\CATIAversion\LucidShapeCAAversion  (e.g., C:
\Users\Public\Documents\LucidShapeCAA\R32\2022.06-1).

10. To specify a different folder, edit the path or click the Browse button to navigate to it and select it.

11. Click Install.

The Setup window shows the progress of the installation.

When the process is complete, Installation Complete is displayed in the Setup window.

12. For LucidShape CAA, this is the final screen in the installation wizard. Click Close and skip to step
14 on page 13. For all other LucidShape products, click Next to exit the LucidShape installation
wizard.

The Completing the LucidShape Setup Wizard screen is displayed.

13. Click Finish.

The installation is complete.
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Note:  LucidShape software will not be able to run if it is blocked by Data Loss Prevention software
or anti-malware software installed on your computer. Contact your system administrator to ensure
that such software has a policy that adds LucidShape software to your allowed software list.

14. Configure your license as described in Configuring LucidShape with a Fixed License on page 13
or Configuring LucidShape with a Floating License on page 16.

15. If you are installing LucidShape CAA, you must perform one more step before you can use this
product. See Specifying Global Settings for NVIDIA Graphics Card on page 65 for instructions.

16. If you are installing LucidShape CAA with a license for the Light Guide Design Module, you must
perform one more step after you install your license key but before you can use this module. See Set
CATIA Option to Preserve Object Naming for the Light Guide Design Module on page 67 for
instructions.

17. If you are installing LucidDriveSC, see the LucidDrive Server/Client document
(LucidDriveSC.pdf ) available in the doc directory of your LucidShapeSC installation directory
for additional instructions.

Configuring LucidShape with a Fixed License
After installing LucidShape with Legacy Licensing, you must configure the license key file.

• If you already have a license key for this product, skip to Installing a License Key for a Fixed License
on page 14.

• If you do not yet have a license key, continue with Obtaining the Host ID for a License Dongle on page
13 and then retrieve your license key as described in Retrieving License Keys on page 58.

In this section:

Obtaining the Host ID for a License Dongle on page 13
A license key is designed to work for only one USB dongle, so the license key is associated with a
unique value encoded on the dongle called a Host ID.

Installing a License Key for a Fixed License on page 14
Follow these instructions to install a license key for a fixed license.

Obtaining the Host ID for a License Dongle
A license key is designed to work for only one USB dongle, so the license key is associated with a unique
value encoded on the dongle called a Host ID.

You must have the USB dongle provided by Synopsys or your local distributor.

You need to know the Host ID for the license dongle before you can retrieve a license key. The Host ID is
printed on a label on the USB dongle. If you are unable to read the ID on the label, you can also obtain the
Host ID by running a program that reads it from the dongle. In the LucidShape installation, the GetHostID
utility is provided for this purpose. Follow these steps to run GetHostID.

1. Insert the USB dongle in an active USB port. A light glows at the end of the dongle when it’s inserted
correctly in an active USB port.

2. Select the Windows Start menu, expand the LucidShape group and select GetHostID, shown in the
following figure.
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The GetHostID utility is displayed. In this example, the Host ID for the USB dongle is 400-
*MMMMMMMMMMMMM. Note that the version number displayed at the top of the GetHostID utility may
vary, depending on the product you’re installing.

3. Copy the Dongle Host ID to use when you retrieve your license key on the Synopsys SolvNetPlus
website. See Retrieving License Keys on page 58 for instructions.

4. Click Done to close the GetHostID utility.

After you retrieve your license key, continue with Installing a License Key for a Fixed License on page
14.

Installing a License Key for a Fixed License
Follow these instructions to install a license key for a fixed license.

To install the license key for a LucidShape product, you must have:

• The LucidShape product installed

• A license dongle

• A valid license key

This procedure assumes that you have already obtained a license key from the SolvNetPlus SmartKeys
web page. If you have not done so, see Retrieving License Keys on page 58 for instructions.

Follow these steps to set up licensing for the LucidShape product.

1. Insert the license dongle in an active USB port. A light glows at the end of the dongle when it’s
inserted correctly in an active USB port.
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The license dongle must remain connected whenever you are running the LucidShape product.

It may take a few minutes for your system to recognize the dongle.

2. Start the LucidShape product. To do this, you can double-click the shortcut icon on the desktop or
select the Windows Start button and navigate to the product name, as shown in the following example.

Start > LucidShape 2020.12 > LucidShape.

The License Check Failed dialog box is displayed, indicating that a valid license key file was not
found.

LucidShape LucidShape CAA

3. Make sure the Fixed option is selected and then click the Install Fixed License button.

The Fixed License Installer dialog box opens.
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4. Click the Browse button .

5. In the Open dialog box, navigate to the license key file, select it, and click Open.

The Open dialog box closes, and the path to the license key file is shown in the Fixed License Installer.

6. Click the Install button.

The license key is installed, and the Success dialog box is displayed.

7. Click OK.

8. Click OK on the License Check Failed dialog box.

9. Start the LucidShape product again.

You can now start working with LucidShape.

Configuring LucidShape with a Floating License
If you are using a floating license, you need to provide the name of the server hosting the OSG Floating
License Manager. Your LucidShape or IT Administrator should have provided you with the name of the
server hosting the OSG Floating License Manager.

If you are installing LucidShape CAA, you may also need to enable specific modules as described in
Optional: Specifying Module Licenses to Activate (LucidShape CAA Only) on page 18.

If you need to install the OSG Floating License Manager, see Installing and Managing the OSG Floating
License Manager (Legacy Licensing) on page 19.

In this section:

Enabling the Floating License on page 17
To enable the floating license to work for your LucidShape installation, you need to specify the name
of your license server in a LucidShape initialization file.
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Optional: Specifying Module Licenses to Activate (LucidShape CAA Only) on page 18
For LucidShape CAA, if you have a license for more than one module, you can specify which of the
licenses you want to activate when you start LucidShape CAA.

Enabling the Floating License
To enable the floating license to work for your LucidShape installation, you need to specify the name of
your license server in a LucidShape initialization file.

Your LucidShape or IT Administrator should have provided you with the name of your OSG Floating
License Manager.

1. Start LucidShape.

The License Check Failed dialog box displays.

LucidShape LucidShape CAA

2. Select the Floating option at the bottom of the dialog box.

3. Delete the text no-net, enter the name of your license server, and click OK.
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The server name is copied to the LucidLicensing.ini file.

4. Restart LucidShape as prompted.

5. Optional: If you have licenses for multiple modules, you can specify which module licenses are
activated when you start LucidShape CAA. See Optional: Specifying Module Licenses to Activate
(LucidShape CAA Only) on page 18 for details.

Optional: Specifying Module Licenses to Activate (LucidShape CAA Only)
For LucidShape CAA, if you have a license for more than one module, you can specify which of the
licenses you want to activate when you start LucidShape CAA.

Before You Begin: You must have enabled your floating license and restarted the product as explained in
Enabling the Floating License on page 17.

1. Select the menu Help > Setup License.

The LucidShape CAA License Setup dialog box is displayed, shown in the following figure.

2. Select the modules that you want to activate or deactivate on startup.

Options that are turned on (checked) are activated on startup, and options that are off (unchecked) are
deactivated on startup.

3. If you would like display the LucidShape CAA License Setup dialog box each time you start the
product so that you can see or specify which module licenses are active when you start LucidShape
CAA, select the show floating license setup on startup check box.

4. Click OK to accept the changes and close the dialog box.

You can now start working with LucidShape CAA.
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Installing and Managing the OSG Floating License Manager (Legacy Licensing)

If you are using floating licenses, you need to install and maintain an OSG Floating License Manager.

The floating license capability is supported by the OSG Floating License Manager, which is a Sentinel
RMS license manager that has been customized for Synopsys OSG software. If you install other Synopsys
OSG software products, they will share the same license management software, and their license keys will
be written to the same license key file. The applications cannot share licenses; they share only the license
server software.

Installing a floating license requires system-administration-level training and should be performed by
someone who is familiar with your network structure. To perform this installation, you must be logged on
as administrator.

The steps for installing OSG Floating License Manager to run with a floating license are:

• Selecting a License Server on page 20

• Downloading and Installing the OSG Floating License Manager on page 20

• Installing a License Key for a Floating License on page 26

• Administering Floating Licenses on page 28

In this section:

Selecting a License Server on page 20
Before installing any software, you must identify the computer that will act as the license server. This
must be a computer connected to a network that can grant access to one or more client machines.

Downloading and Installing the OSG Floating License Manager on page 20
You must have the OSG Floating License Manager, which is provided on the SolvNetPlus website on
the same Downloads page as the product software.

Obtaining the Host ID for a License Dongle on page 25
A license key is designed to work for only one USB dongle, so the license key is associated with a
unique value encoded on the dongle called a Host ID.

Installing a License Key for a Floating License on page 26
After you install the license server software and retrieve a license key, you need to install the license
key on the license server before client machines can successfully run LucidShape. The Floating
License Installer is provided for this purpose.

Administering Floating Licenses on page 28
In general, there is nothing that you need to do to administer the floating licenses. As long as the
floating license server machine is operational, connected to the network, and is running the Sentinel
service, licenses are available to clients.
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Selecting a License Server
Before installing any software, you must identify the computer that will act as the license server. This must
be a computer connected to a network that can grant access to one or more client machines.

For any one product, it is not possible to have two sets of license keys (locked to different dongles) on the
same floating license server. Each set of license keys is composed of a set of exclusive module licenses;
because of this, if you install license keys for a product and then add a second set of license keys for that
product, the second set of license keys will override the first set.

If you want to use a second dongle, you need to setup a second license server. In principle it is possible
to combine license keys on one dongle, this depends among other on the modules and the respective
expiration date. Please contact your LucidShape representative at lucidshape_support@synopsys.com for
more information.

Note:  The OSG Floating License Manager communicates via port 5093. If you will be running
LucidShape across different subnets, you will have to configure your routers or firewalls to allow two-
way communication across this port.

Downloading and Installing the OSG Floating License Manager
You must have the OSG Floating License Manager, which is provided on the SolvNetPlus website on the
same Downloads page as the product software.

See Using SolvNetPlus to Obtain LucidShape Software and Licenses on page 51 for details. Follow
these steps to install the OSG Floating License Manager on the license server.

Note:  If you have a different version of the Sentinel RMS software, you must first uninstall the older
version, as described in step 2 on page 20.

1. Log on to the license server with administrator privileges.

2. If any version of the OSG Floating License Manager or the Sentinel RMS License Manager software is
installed on the license server computer, you must uninstall it using the following sub-steps. If no prior
version is installed, skip to step 3 on page 20.

a) Open the Control Panel and select Programs and Features.

If the list includes both the OSG Floating License Manager Admin Tools and the Sentinel RMS
License Manager, shown in the following figure, you must uninstall both of these.

b) Select the program to uninstall and then click Uninstall/Change.

c) Follow the instructions on screen.

3. Navigate to the folder where the setup file is located.

4. Double-click the setup file FloatingLM.exe.
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The Welcome screen for the OSG Floating Manager Admin Tools wizard is displayed.

5. Click Next.

The License Agreement screen for the OSG Floating License Manager Admin Tools is displayed.

6. Click the I Accept option and click Next to continue.

The Ready to Install screen is displayed.

7. Click Install.

The progress screen is displayed while the software is installed.
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8. Accept the default values for all questions.

The Welcome screen for the Sentinel RMS License Manager is displayed.

9. Click Next.

The License Agreement screen for the Sentinel RMS License Manager wizard is displayed.

10. Click the I Accept option and then click Next to continue.

The Customer Information dialog box is displayed.
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11. Click Next to accept the defaults and continue.

The Destination Folder screen is displayed.

12. Click Next to accept the default and continue.

The Setup Type screen is displayed.

13. Click Next to accept Complete (recommended) and continue.

The System Firewall Settings screen is displayed.
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14. Leave the option turned on (checked) and click Next.

This setting allows the Floating License Manager to add inbound rules. If you change this setting,
LucidShape will not be able to obtain the license needed to run.

The Ready to Install screen is displayed.

15. Click Install.

The progress screen is displayed while the software is installed.

When the installation is finished, the Completed screen for the Sentinel License Manager is displayed.
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16. Click Finish.

The wizard finishes installing the OSG Floating License Manager Admin Tools, and then the
Completed screen is displayed.

17. Click Finish.

The installation is complete.

18. Reboot your computer if prompted to do so.

If you already have a license key for this product, skip to Installing a License Key for a Floating License
on page 26. If you do not yet have a license key, continue with Obtaining the Host ID for a License
Dongle on page 25.

Obtaining the Host ID for a License Dongle
A license key is designed to work for only one USB dongle, so the license key is associated with a unique
value encoded on the dongle called a Host ID.

You must have the USB dongle provided by Synopsys or your local distributor.

You need to know the Host ID for the license dongle before you can retrieve a license key. The Host ID is
printed on a label on the USB dongle. If you are unable to read the ID on the label, you can also obtain the
Host ID by running a program that reads it from the dongle. In the LucidShape installation, the GetHostID
utility is provided for this purpose. Follow these steps to run GetHostID.

1. Insert the USB dongle in an active USB port. A light glows at the end of the dongle when it’s inserted
correctly in an active USB port.

2. Select the Windows Start menu, expand the LucidShape group and select GetHostID, shown in the
following figure.
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The GetHostID utility is displayed. In this example, the Host ID for the USB dongle is 400-
*MMMMMMMMMMMMM. Note that the version number displayed at the top of the GetHostID utility may
vary, depending on the product you’re installing.

3. Copy the Dongle Host ID to use when you retrieve your license key on the Synopsys SolvNetPlus
website. See Retrieving License Keys on page 58 for instructions.

4. Click Done to close the GetHostID utility.

After you retrieve your license key, continue with Installing a License Key for a Floating License on
page 26.

Installing a License Key for a Floating License
After you install the license server software and retrieve a license key, you need to install the license key on
the license server before client machines can successfully run LucidShape. The Floating License Installer is
provided for this purpose.

This procedure assumes that you have already obtained a valid license file from the SolvNetPlus
SmartKeys web page. If you have not done so, see Retrieving License Keys on page 58 for
instructions.

Note:  For any one product, it is not possible to have two sets of license keys (locked to different
dongles) on the same floating license server. Each set of license keys is composed of a set of exclusive
module licenses; because of this, if you install license keys for a product and then add a second set of
license keys for that product, the second set of license keys will override the first set.

If you want to use a second dongle, you need to setup a second license server. In principle it is possible
to combine license keys on one dongle, this depends among other on the modules and the respective
expiration date. Please contact your LucidShape representative at lucidshape_support@synopsys.com for
more information.

Follow these steps to install your license key.

1. Make sure that the license dongle is inserted in an active USB port on the license server. A light glows
at the end of the dongle when it’s inserted correctly in an active USB port.
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It may take a few minutes for your system to recognize the dongle.

2. Click the Windows Start button on the taskbar, and navigate to OSG Floating License Manager.
Right-click Floating License Installer and select Run as Administrator.

The Floating License Installer is displayed, as shown in the following figure.

3. Click the Browse button .

4. In the Open dialog box, navigate to the license key file, select it, and click Open.

The Open dialog box is closed, and the path to the license key file is shown in the Floating License
Installer.

5. Click the Install button.

The license key is installed, and the Success dialog box is displayed.
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6. To close the Floating License Installer, click the X in the top right corner.

Continue with Administering Floating Licenses on page 28.

Administering Floating Licenses
In general, there is nothing that you need to do to administer the floating licenses. As long as the floating
license server machine is operational, connected to the network, and is running the Sentinel service,
licenses are available to clients.

In this section:

Monitoring License Use on page 28
It is possible for all available licenses to be in use, which would prevent additional clients from
running LucidShape. In such cases, a system administrator can use the Sentinel Administrator Utility
(WlmAdmin) to determine to whom the module licenses have been allocated.

Improving Access to LucidShape Licenses with the Sentinel License Manager on page 29
By default, LucidShape licenses are available to anyone on your server on a first-come, first-served
basis. Therefore, you can use LucidShape immediately without using the OSG Floating License
Manager. However, if you want to control access to these licenses based on work priorities, you can
use the Sentinel Administrator Utility to reserve copies for or deny access to specific users.

Logging Floating License Usage on page 33
Floating license usage is automatically recorded in the file usage.log.

Monitoring License Use
It is possible for all available licenses to be in use, which would prevent additional clients from running
LucidShape. In such cases, a system administrator can use the Sentinel Administrator Utility (WlmAdmin)
to determine to whom the module licenses have been allocated.

Note:  To use the Administrator Utility utility, you must be the person who started the license server, or
you must have administrator privileges.

1. To start the utility, click the Windows Start menu and select Programs > OSG Floating License
Manager > Administrator Utility.

2. Expand the list of modules below the license server hostname.
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The details presented in the dialog box indicate which client machine and username have checked
out the licenses. The example below shows that from the license server machine INSPIRONAMD,
a LucidShape license is checked out to a user named JDoe, who is using a client machine named
JDoe-z400_1.

You can also use the Administrator Utility utility to obtain other licensing activity information, such
as license servers detected, details on active licenses, etc. For more information about how to use the
Administrator Utility utility, see the Sentinel System Administrator’s Guide. After the Sentinel software is
installed, this manual is available by selecting the Windows Start menu and selecting Programs > OSG
Floating License Manager > System Administrator’s Guide.

Note:  Not all functions described in the Sentinel System Administrator’s Guide are supported by
LucidShape.

Improving Access to LucidShape Licenses with the Sentinel License Manager
By default, LucidShape licenses are available to anyone on your server on a first-come, first-served basis.
Therefore, you can use LucidShape immediately without using the OSG Floating License Manager.
However, if you want to control access to these licenses based on work priorities, you can use the Sentinel
Administrator Utility to reserve copies for or deny access to specific users.

Before using the Administrator Utility, consider how you want to organize your groups, keeping in mind
the following points:

• Anyone on your server can use a license that has not been explicitly reserved.

• After you create a group, you can specify the status of individual members as Included (access
allowed) or Excluded (access denied).
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• You can exclude all members of a group from using licenses (called license tokens) by specifying 0
licenses for that group.

For example:

• Organize by department:

If you have departments in your organization, enter each department as a separate group, assign the
appropriate number of license tokens to each group, and designate each group member as Included or
Excluded. You can change this designation for members as needed, according to work priorities.

• Organize by priority:

Create a group for preferred users and another group for everyone else. In the preferred user group,
designate all members as Included and assign to them as many licenses as you can allow. For the
second group, you enter everyone else in the company, assign the remaining license tokens, and
designate which people are Included and which are Excluded. You can change the Included and
Excluded designations as the work load changes.

When you are ready to implement this arrangement, you can use the Administration Utility provided with
the OSG License Manager to create a reservation file, as described in the following steps.

1. On the license manager server, start the license manager Administration Utility from the Windows
Start button:

Start > All Programs > OSG Floating License Manager > Administrator Utility

The WlmAdmin dialog box is displayed.

2. From the menu at the top of the WlmAdmin window, select Edit > Reservation File.

The Wlsgrmgr dialog box is displayed.

3. To set up a new members group, select File > New.

4. Follow these steps to select a feature.

a) Select Feature > Add.

The Add License Reservation Wizard is displayed.

b) Click Next to continue.

The Feature Version Capacity dialog box is displayed.

c) Enter the appropriate Feature Name.
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You must enter feature names as they appear in the WlmAdmin dialog box, shown in the following
example.

d) For the Feature Version, enter ORA (upper case).

e) Click Next.

The Group dialog box is displayed.

5. To establish a user group, follow these steps.

a) Enter a name that identifies the user group for which you want to allow or deny access.
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b) In the Tokens field, enter the number of licenses to reserve for that group.

c) Click Next.

The Members dialog box is displayed.

6. To add members to the group, follow these steps.

Note:  You can add members who will be allowed access, as well as members who will be denied
access.

a) Click the Add button.

The Member dialog box is displayed.

b) Keep the User option selected, shown in the following figure, and enter the member’s name in the
Name of the Member field. You can define members only by user name and not by Machine.

c) Click Included for members who are allowed access or Excluded for members who are denied
access.
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d) Click OK on the Member window and repeat the process to add each user in the group.

e) Click Finish on the Members window to apply the changes and close the window.

7. Repeat the process of selecting a feature, establishing a group, and adding members for each group
(steps step 4 on page 30, step 5 on page 31, and step 6 on page 32).

8. Select File > Save As and navigate the directory where the license manager is installed.

By default, the license manager is installed in C:\Program Files (x86)\Common Files
\SafeNet Sentinel\Sentinel RMS License Manager\WinNT.

The file lsreserv is created and saved at this location. The license manager references this file to
determine which users have access to each feature.

9. Restart the Sentinel RMS License Manager, as described in the following steps.

a) Click the Windows Start button and select Control Panel.

b) Click Administrative Tools.

c) Double-click Services.

d) In the Services dialog box, locate and right-click the Sentinel RMS License Manager and select
the Restart option on the pop-up menu.

Logging Floating License Usage
Floating license usage is automatically recorded in the file usage.log.

The following example shows how information is formatted in this file.

As shown in the highlighted portions, the entries include:

• 1 - day, date, and time stamp

• 2 - the product or module

• 3 - a code that indicates whether the license was issued (0), denied (1), or released (2)

• 4 - the number of floating licenses in use after the current release or request

• 5 - elapsed time the license was in use (in seconds)

This value is 0 until the license is released.

• 6 - the user ID

• 7 - the host name

• 8 - the version number for the floating license manager
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By default, the usage.log file is located in the folder C:\Windows\SYSWOW64. You can change the
location and name of the file, if desired, as described in the following steps.

1. Select the Windows Start menu and select Control Panel > System.

2. In the top left corner, select Advanced system settings.

3. In the System Properties dialog box, select the Advanced tab and click Environment Variables.

4. In the Environmental Variables dialog box, select LSERVOPTS and click Edit.
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By default, the value for LSERVOPTS is

-l usage.log -z 20m -f error.log

5. In the Edit System Variable dialog box, change the path and/or file name by replacing the string
usage.log with the desired path and file name.
In the following example, the new path for the file is C:\temp\usage.log.

6. Restart the license manager in the services list, as described in the following steps.

The change takes effect after the license manager is restarted.

a) Select the Windows Start menu and select Control Panel > Administrative Tools.

b) Double-click Services.

c) In the Services dialog box, locate and select the Sentinel RMS License Manager.
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d) Click Restart the service option.

For additional information about the usage log, See the Sentinel System Administrator’s Guide. After the
license manager software is installed, this manual is available by selecting the Windows Start menu and
selecting Programs > OSG Floating License Manager > System Administrator’s Guide.
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Installing LucidShape with Synopsys Common Licensing

The 2023.03 version of the LucidShape family of products is the first release that can support Host IDs 
compatible with Synopsys Common Licensing.

The instructions in this section are intended for LucidShape users installing the application on their 
systems. If you are the LucidShape or IT Administrator and need to install the Synopsys Common 
Licensing server, go to Installing and Managing the Synopsys Common Licensing Server on page 44.

Note:  The LucidShape installer includes and automates the Synopsys Common Licensing installation
and configuration.

If you are already using Synopsys Common Licensing for other applications, speak with your LucidShape
representative.

In this section:

Installing LucidShape with a Nodelocked License on page 37
When you install LucidShape with an Synopsys Common Licensing nodelocked license you can
configure your licensing information as you run through the installation.

Installing LucidShape Network (Client Installation) on page 40
Using this type of license, the licenses are installed and managed by an Synopsys Common Licensing
server.

Installing LucidShape with a Nodelocked License
When you install LucidShape with an Synopsys Common Licensing nodelocked license you can configure
your licensing information as you run through the installation.

These instructions assume that you have already downloaded LucidShape from the Synopsys SolvNetPlus
website or that you ordered and received a LucidShape DVD.

These instructions also assume you have a license key for this product.

If you do not have either the installer or the license key, see Using SolvNetPlus to Obtain LucidShape
Software and Licenses on page 51.

Installing LucidShape with a Nodelocked License
Follow these instructions to install LucidShape on your system using the Synopsys Common Licensing
method with a nodelocked license.

Note:  You cannot use this type of licensing for LucidDriveSC.

You should know the location of your license key file.

If you do not have a license key file yet because you need a Host ID, you can run the installer without
providing valid values to install all the Synopsys Common Licensing utilities. Then you can follow the
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instructions in Obtaining the Host ID for a Dongle for a Synopsys Common Licensing Installation on page
49 to get your Host ID so you can retrieve your license key file as explained in Retrieving License
Keys on page 58.

You may need a USB dongle acquired by you or your site’s license administrator from your local Synopsys
Sales Representative. Your LucidShape or IT Administrator should inform you if one is required. If you are
the LucidShape or IT Administrator, contact your LucidShape representative. If you do require a dongle, it
should be plugged into your machine.

1. Log on to your computer as Administrator.

2. Navigate to the folder where the LucidShape setup file is located. If you have a DVD, insert it into the
DVD drive and navigate to that drive.

3. Double-click the setup file (e.g., SetupLucidShape_version.exe)

where version is the version number for the release (e.g., SetupLucidShape_2022.03.exe).
For the LucidShape CAA V5 Based product, the file name also includes the CATIA version (e.g.,
SetupLucidShapeCAA_R32_2022.06-1.exe).

The Setup window is displayed at the License Agreement screen.

4. Click I Agree to continue.

The Choose Install Location screen is displayed.

5. Specify a location.

If an earlier release of the product was installed, the default location will be set to the path used for that
release. If you want to install the program in a different folder, click the Browse button to locate and
specify that folder.

For most LucidShape products, the default location is C:\productName_version.

For LucidShape CAA, the default location is C:\Program Files\Synopsys
\LucidShapeCAA\CATIAversion\LucidShapeCAAversion.

6. After selecting a Destination folder, click Next.
The License Installation Options screen is displayed.

These instructions are for the Synopsys Common Licensing installation with a nodelocked license. If
you need to use Legacy Licensing, see Installing LucidShape with Legacy Licensing on page 10.

7. Select My license is for Synopsys Common Licensing and click Next.
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For LucidShape and LucidDrive, the License Type Setup screen is displayed. Skip to step step 12 on
page 39.

For LucidShape CAA, the Choose CATIA Installation Directory screen is displayed. The Choose
CATIA Installation Directory screen allows you to associate the LucidShape CAA product with
a specific CATIA installation. If a CATIA installation folder was detected, the path to that folder is
displayed in the input field. If CATIA is not installed on the same computer, or if CATIA is managed
by a third-party tool that maintains configurations and versions, the input field may be blank, and
you may need to perform additional steps to complete your installation. See Troubleshooting the
LucidShape CAA V5 Based Installation on page 63 for details.

8. If you need to specify or want to change the CATIA installation folder, edit the path or click the
Browse button to navigate to it and select it.

9. Click Next to continue.

The Choose Public Data Location screen is displayed. This allows you to specify a location for
installing public data, such as example model files. To allow interactive use of these files, choose
a folder for which you have write permission. The default location is C:\Users\Public
\Documents\LucidShapeCAA\CATIAversion\LucidShapeCAAversion  (e.g., C:
\Users\Public\Documents\LucidShapeCAA\R32\2022.06-1).

10. To specify a different folder, edit the path or click the Browse button to navigate to it and select it.

11. Click Install.

The LucidShape installer starts the Synopsys Common Licensing installation process.

The License Type Setup screen is displayed.

12. Select Nodelocked and click Next.

The License Key File Setup screen is displayed.

13. Click Browse and navigate to the location of your License Key File. Select your file and click Open.
Then click Next after confirming your license key file is selected.

The SCL Installer Setup screen is displayed.

If you receive a warning that some applications are running, select Do not close the applications and
then click Next.

14. Leave the location blank and click Next.

The LucidShape installer includes a Synopsys Common Licensing installer and uses it by default.

Installation Guide for LucidShape Products 2023.03 • 39



Installing LucidShape with Synopsys Common Licensing

Only choose a different installer if instructed by LucidShape Customer Support.

The LucidShape installer installs all the required Synopsys Common Licensing components.

15. When the Synopsys Common Licensing installation completes, click OK.

The LucidShape installer continues to install the LucidShape product.

16. Click Install.

The Setup window shows the progress of the installation.

When the process is complete, Installation Complete is displayed in the Setup window.

17. For LucidShape CAA, this is the final screen in the installation wizard. Click Close and skip to step 14
on page 13. For all other LucidShape products, click Next to exit the LucidShape installation wizard.

The Completing the LucidShape Setup Wizard screen is displayed.

18. Click Finish.

The installation is complete.

Note:  LucidShape software will not be able to run if it is blocked by Data Loss Prevention software
or anti-malware software installed on your computer. Contact your system administrator to ensure
that such software has a policy that adds LucidShape software to your allowed software list.

19. If you are installing LucidShape CAA, you must perform one more step before you can use this
product. See Specifying Global Settings for NVIDIA Graphics Card on page 65 for instructions.

20. If you are installing LucidShape CAA with a license for the Light Guide Design Module, you must
perform one more step after you install your license key but before you can use this module. See Set
CATIA Option to Preserve Object Naming for the Light Guide Design Module on page 67 for
instructions.

21. If you are installing LucidDriveSC, see the LucidDrive Server/Client document
(LucidDriveSC.pdf ) available in the doc directory of your LucidShapeSC installation directory
for additional instructions.

If you were unable to configure your Synopsys Common Licensing license key during installation, you can
configure it later. See Modifying License Options on page 50.

Installing LucidShape Network (Client Installation)
Using this type of license, the licenses are installed and managed by an Synopsys Common Licensing
server.

You need the Synopsys Common Licensing server host name and the port used by your organization. This
should be provided by your LucidShape or IT administrator.

These instructions assume that you have already downloaded LucidShape from the Synopsys SolvNetPlus
website or that you ordered and received a LucidShape DVD.

If you do not have the installer, see Using SolvNetPlus to Obtain LucidShape Software and Licenses on
page 51.

If you are the LucidShape or IT administrator, you need to install the Synopsys Common Licensing server
first. See Installing LucidShape with a Network (Server Installation) on page 44.
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1. Log on to your computer as Administrator.

2. Navigate to the folder where the LucidShape setup file is located. If you have a DVD, insert it into the
DVD drive and navigate to that drive.

3. Double-click the setup file (e.g., SetupLucidShape_version.exe)

where version is the version number for the release (e.g., SetupLucidShape_2022.03.exe).
For the LucidShape CAA V5 Based product, the file name also includes the CATIA version (e.g.,
SetupLucidShapeCAA_R32_2022.06-1.exe).

The Setup window is displayed at the License Agreement screen.

4. Click I Agree to continue.

The Choose Install Location screen is displayed.

5. Specify a location.

If an earlier release of the product was installed, the default location will be set to the path used for that
release. If you want to install the program in a different folder, click the Browse button to locate and
specify that folder.

For most LucidShape products, the default location is C:\productName_version.

For LucidShape CAA, the default location is C:\Program Files\Synopsys
\LucidShapeCAA\CATIAversion\LucidShapeCAAversion.

6. After selecting a Destination folder, click Next.
The License Installation Options screen is displayed.

These instructions are for the Synopsys Common Licensing installation with a Network (Client
Installation) license. If you need to use Legacy Licensing, see Installing LucidShape with Legacy
Licensing on page 10.

7. Select My license is for Synopsys Common Licensing and click Next.

For LucidShape and LucidDrive, the License Type Setup screen is displayed. Skip to step step 12 on
page 42.

For LucidShape CAA, the Choose CATIA Installation Directory screen is displayed. The Choose
CATIA Installation Directory screen allows you to associate the LucidShape CAA product with
a specific CATIA installation. If a CATIA installation folder was detected, the path to that folder is
displayed in the input field. If CATIA is not installed on the same computer, or if CATIA is managed
by a third-party tool that maintains configurations and versions, the input field may be blank, and
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you may need to perform additional steps to complete your installation. See Troubleshooting the
LucidShape CAA V5 Based Installation on page 63 for details.

8. If you need to specify or want to change the CATIA installation folder, edit the path or click the
Browse button to navigate to it and select it.

9. Click Next to continue.

The Choose Public Data Location screen is displayed. This allows you to specify a location for
installing public data, such as example model files. To allow interactive use of these files, choose
a folder for which you have write permission. The default location is C:\Users\Public
\Documents\LucidShapeCAA\CATIAversion\LucidShapeCAAversion  (e.g., C:
\Users\Public\Documents\LucidShapeCAA\R32\2022.06-1).

10. To specify a different folder, edit the path or click the Browse button to navigate to it and select it.

11. Click Install.

The LucidShape installer starts the Synopsys Common Licensing installation process.

The License Type Setup screen is displayed.

12. Select Network (Client Installation) and click Next.

The Network Client Setup screen is displayed.

13. Enter the information for the Synopsys Common Licensing server.

This information should be provided by your LucidShape or IT Administrator.

Minimally, enter the host name of the Synopsys Common Licensing server, for example:
mySCLServer. If your organization uses a different port than the default (27020), include the
port number using the format port@server name, for example: 12345@mySCLServer.
Some organizations may have multiple Synopsys Common Licensing servers. In this
case, enter the different servers using a list separated by semi-colons (;), for example:
12345@mySCLServer;BackupSCLServer. Synopsys Common Licensing checks the servers in
order.

The SCL Installer Setup screen is displayed.

14. When the Synopsys Common Licensing installation completes, click OK.

The LucidShape installer continues to install the LucidShape product.

15. For LucidShape CAA, this is the final screen in the installation wizard. Click Close and skip to step 14
on page 13. For all other LucidShape products, click Next to exit the LucidShape installation wizard.
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The Completing the LucidShape Setup Wizard screen is displayed.

16. Click Finish.

The installation is complete.

Note:  LucidShape software will not be able to run if it is blocked by Data Loss Prevention software
or anti-malware software installed on your computer. Contact your system administrator to ensure
that such software has a policy that adds LucidShape software to your allowed software list.

17. If you are installing LucidShape CAA, you must perform one more step before you can use this
product. See Specifying Global Settings for NVIDIA Graphics Card on page 65 for instructions.

18. If you are installing LucidShape CAA with a license for the Light Guide Design Module, you must
perform one more step after you install your license key but before you can use this module. See Set
CATIA Option to Preserve Object Naming for the Light Guide Design Module on page 67 for
instructions.

19. If you are installing LucidDriveSC, see the LucidDrive Server/Client document
(LucidDriveSC.pdf ) available in the doc directory of your LucidShapeSC installation directory
for additional instructions.
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Chapter 5 Installing and Managing the Synopsys
Common Licensing Server
Installing and Managing the Synopsys Common Licensing Server

If you are using Synopsys Common Licensing network licensing, you need to install the Synopsys
Common Licensing server.

The Network (Client Installation) capability is supported by the Synopsys Common Licensing server.

If you are already using Synopsys Common Licensing in your organization, speak with LucidShape
Customer Support before continuing.

Synopsys Optical Solutions software products cannot share licenses with each other; they share only
the license server software. A single license server can be used to serve all Synopsys Optical Solutions
products that support Synopsys Common Licensing. If you would like to consolidate your license serving
needs, contact your local Synopsys Sales Representative for guidance on procuring licenses.

Installing Synopsys Common Licensing server should be done by your LucidShape or IT administrator. It
requires system-administration-level training and should be performed by someone who is familiar with
your network structure. To perform this installation, you must be logged on as administrator.

In this section:

Installing LucidShape with a Network (Server Installation) on page 44
This procedure should be followed by the LucidShape or IT administrator who manages all the Optical
Solutions licenses for an organization.

Working with Synopsys Common Licensing on page 48
Synopsys Common Licensing is a stand-alone application with many features and utilities. This section
highlights some common tasks you may need to perform to install LucidShape.

Installing LucidShape with a Network (Server Installation)
This procedure should be followed by the LucidShape or IT administrator who manages all the Optical
Solutions licenses for an organization.

The Optical Solutions installer streamlines the LucidShape family product installation and the Synopsys
Common Licensing installation. When you select the Network (Server Installation), the LucidShape
installer installs the Synopsys Common Licensing server. It also installs the LucidShape product.

As long as you do not run the LucidShape product on the Synopsys Common Licensing server machine,
you do not use a license.

In this section:

Selecting a Synopsys Common Licensing License Server on page 45
Before installing any software, you must identify the computer that will act as the license server. This
must be a computer connected to a network through which it can communicate with one or more client
computers.
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Installing LucidShape Network (Server) on page 45
Follow these instructions to install LucidShape and the Synopsys Common Licensing server.

Selecting a Synopsys Common Licensing License Server
Before installing any software, you must identify the computer that will act as the license server. This
must be a computer connected to a network through which it can communicate with one or more client
computers.

Note:  By default, Synopsys Common Licensing communicates via port 27020 and 27021. If you will be
running LucidShape across different subnets, you will have to configure your routers or firewalls to allow
two-way communication across your designated ports.

When specifying the server name for a network client, specify the port and the server name or IP
address. By default, the server uses port 27020, therefore enter, for example, 27020@MyServer or
27020@123.456.78.90.

The LucidShape installer supports installing Synopsys Common Licensing on the following Windows
operating systems: Windows OS 10, Windows Server 2016, Windows Server 2019.

Installing LucidShape Network (Server)
Follow these instructions to install LucidShape and the Synopsys Common Licensing server.

These instructions assume that you have already downloaded LucidShape from the Synopsys SolvNetPlus
website or that you ordered and received a LucidShape DVD.

These instructions also assume you have a license key for this product.

If you do not have either the installer or the license key, see Using SolvNetPlus to Obtain LucidShape
Software and Licenses on page 51.

Your installation may also require a dongle. Contact your LucidShape representative to confirm. If you do
require a dongle, it should be plugged in to your machine.

1. Log on to your computer as Administrator.

2. Navigate to the folder where the LucidShape setup file is located. If you have a DVD, insert it into the
DVD drive and navigate to that drive.

3. Double-click the setup file (e.g., SetupLucidShape_version.exe)

where version is the version number for the release (e.g., SetupLucidShape_2022.03.exe).
For the LucidShape CAA V5 Based product, the file name also includes the CATIA version (e.g.,
SetupLucidShapeCAA_R32_2022.06-1.exe).

The Setup window is displayed at the License Agreement screen.

4. Click I Agree to continue.

The Choose Install Location screen is displayed.

5. Specify a location.

If an earlier release of the product was installed, the default location will be set to the path used for that
release. If you want to install the program in a different folder, click the Browse button to locate and
specify that folder.

For most LucidShape products, the default location is C:\productName_version.
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For LucidShape CAA, the default location is C:\Program Files\Synopsys
\LucidShapeCAA\CATIAversion\LucidShapeCAAversion.

6. After selecting a Destination folder, click Next.
The License Installation Options screen is displayed.

These instructions are for the Synopsys Common Licensing installation with a network license. If you
need to use Legacy Licensing, see Installing LucidShape with Legacy Licensing on page 10.

7. Select My license is for Synopsys Common Licensing and click Next.

For LucidShape and LucidDrive, the License Type Setup screen is displayed. Skip to step step 12 on
page 47.

For LucidShape CAA, the Choose CATIA Installation Directory screen is displayed. The Choose
CATIA Installation Directory screen allows you to associate the LucidShape CAA product with
a specific CATIA installation. If a CATIA installation folder was detected, the path to that folder is
displayed in the input field. If CATIA is not installed on the same computer, or if CATIA is managed
by a third-party tool that maintains configurations and versions, the input field may be blank, and
you may need to perform additional steps to complete your installation. See Troubleshooting the
LucidShape CAA V5 Based Installation on page 63 for details.

8. If you need to specify or want to change the CATIA installation folder, edit the path or click the
Browse button to navigate to it and select it.

9. Click Next to continue.

The Choose Public Data Location screen is displayed. This allows you to specify a location for
installing public data, such as example model files. To allow interactive use of these files, choose
a folder for which you have write permission. The default location is C:\Users\Public
\Documents\LucidShapeCAA\CATIAversion\LucidShapeCAAversion  (e.g., C:
\Users\Public\Documents\LucidShapeCAA\R32\2022.06-1).
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10. To specify a different folder, edit the path or click the Browse button to navigate to it and select it.

11. Click Install.

The LucidShape installer starts the Synopsys Common Licensing installation process.

The License Type Setup screen is displayed.

12. Select Network (Server Installation) and click Next.

The License Key File Setup screen is displayed.

13. Click Browse and navigate to the location of your License Key File. Select your file and click Open.
Then click Next after confirming your license key file is selected.

The SCL Installer Setup screen is displayed.

If you receive a warning that some applications are running, select Do not close the applications and
then click Next.

14. Leave the location blank and click Next.

The LucidShape installer includes a Synopsys Common Licensing installer and uses it by default.

Only choose a different installer if instructed by LucidShape Customer Support.

The LucidShape installer installs all the required Synopsys Common Licensing components.

15. When the Synopsys Common Licensing installation completes, click OK.

The LucidShape installer continues to install the LucidShape product.

16. For LucidShape CAA, this is the final screen in the installation wizard. Click Close and skip to step 14
on page 13. For all other LucidShape products, click Next to exit the LucidShape installation wizard.

The Completing the LucidShape Setup Wizard screen is displayed.

17. Click Finish.

The installation is complete.

Note:  LucidShape software will not be able to run if it is blocked by Data Loss Prevention software
or anti-malware software installed on your computer. Contact your system administrator to ensure
that such software has a policy that adds LucidShape software to your allowed software list.
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18. If you are installing LucidShape CAA, you must perform one more step before you can use this
product. See Specifying Global Settings for NVIDIA Graphics Card on page 65 for instructions.

19. If you are installing LucidShape CAA with a license for the Light Guide Design Module, you must
perform one more step after you install your license key but before you can use this module. See Set
CATIA Option to Preserve Object Naming for the Light Guide Design Module on page 67 for
instructions.

20. If you are installing LucidDriveSC, see the LucidDrive Server/Client document
(LucidDriveSC.pdf ) available in the doc directory of your LucidShapeSC installation directory
for additional instructions.

Working with Synopsys Common Licensing
Synopsys Common Licensing is a stand-alone application with many features and utilities. This section
highlights some common tasks you may need to perform to install LucidShape.

The LucidShape installer includes the version of Synopsys Common Licensing recommended by
Optical Solutions for working with LucidShape. The LucidShape installer automates the installation and
configuration of Synopsys Common Licensing for you.

LucidShape includes tools to simplify the interaction with the Synopsys Common Licensing server that are
specific to LucidShape.

The complete documentation for Synopsys Common Licensing is installed with the Synopsys Common
Licensing components installed by the LucidShape installer. By default, that location is C:\Synopsys
\SCL\SCL Version\doc. You can also find the documentation on SolvNetPlus.

In this section:

Obtaining the Host ID for a Synopsys Common Licensing Installation on page 48
If you install a nodelocked or Synopsys Common Licensing server, Synopsys Common Licensing
includes the FlexNet lmhostid command to determine the Host ID of a machine.

Obtaining the Host ID for a Dongle for a Synopsys Common Licensing Installation on page 49
You can use the lmhostid command to retrieve the Host ID for a dongle, but you need an extra
option.

Check License on page 49
Use this option to determine what your current licensing is.

Modifying License Options on page 50
While the intention of the LucidShape installer is to install and configure Synopsys Common Licensing
during the installation process, you can make changes after the installation completes.

Administering Licenses on page 50
As a Synopsys Common Licensing administrator, you can configure and control how licenses are
distributed in your organization.

Obtaining the Host ID for a Synopsys Common Licensing Installation
If you install a nodelocked or Synopsys Common Licensing server, Synopsys Common Licensing includes
the FlexNet lmhostid command to determine the Host ID of a machine.
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The LucidShape installer for nodelocked or Synopsys Common Licensing server installs a utility to quickly
check your Host ID.

Select the Start Menu > Synopsys SCL > lmhostid.

This opens a command prompt that displays the Host ID information, similar to the example below.

You can also run the command manually.

The LucidShape installer installs the Synopsys Common Licensing utilities in C:\Synopsys\SCL\SCL
Version\win32\bin.

You can install Synopsys Common Licensing for nodelocked or Synopsys Common Licensing server
without configuring it with valid values for the license key. This installs all the utilities you need to get the
Host IDs.

1. From a command prompt, navigate to C:\Synopsys\SCL\SCL Version\win32\bin.

2. Enter the command lmhostid.

C:\Synopsys\SCL\2022.12\win32\bin>lmhostid
lmhostid - Copyright (c) 1989-2022 Flexera. All Rights Reserved.
The FlexNet host ID of this machine is "1234567ab89"

This command may return multiple values depending upon your machine. You can use any single value.

Obtaining the Host ID for a Dongle for a Synopsys Common Licensing Installation
You can use the lmhostid command to retrieve the Host ID for a dongle, but you need an extra option.

The LucidShape installer installs the Synopsys Common Licensing utilities in C:\Synopsys\SCL\SCL
Version\win32\bin.

You can install Synopsys Common Licensing for nodelocked or Synopsys Common Licensing server
without configuring it with valid values for the license key. The LucidShape installer installs the
application, and all the utilities you need to get the Host ID.

You can update the Synopsys Common Licensing configuration after installation as described in Modifying
License Options on page 50.

1. Insert the USB dongle in an active USB port. A light glows at the end of the dongle when it’s inserted
correctly in an active USB port.

2. From a command prompt, navigate to C:\Synopsys\SCL\SCL Version\win32\bin.

3. Enter the command lmhostid -flexid.

C:\Synopsys\SCL\2022.12\win32\bin>lmhostid -flexid
lmhostid - Copyright (c) 1989-2022 Flexera. All Rights Reserved.
The FlexNet host ID of this machine is "FLEXID=10-3abc4cba"

Check License
Use this option to determine what your current licensing is.

1. Make sure you have your LucidShape Messages window open.

• LucidDrive: Select the menu Windows > Message.

• LucidShape: Select the menu Window > Open Message View.

• LucidShape CAA: Select the menu LS Tools > Open Message Window.
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2. In your LucidShape product, select the menu Help > Check License.

LucidShape runs diagnostics and writes your current license settings to the Messages window.

Modifying License Options
While the intention of the LucidShape installer is to install and configure Synopsys Common Licensing
during the installation process, you can make changes after the installation completes.

1. From your LucidShape product, select the menu Help > Setup License.
The License Setup dialog box opens.

2. If you need to change your license method, you can choose between Legacy Licensing and Synopsys
Common Licensing.

3. If you select Synopsys Common Licensing, click the Setup SCL Licensing button to make changes to
your Synopsys Common Licensing license type or settings.

Use this option to :

• Switch between nodelocked and network license types

• Configure a new license key file

• Change the Synopsys Common Licensing server hostname or port a network client points to

The Setup SCL Licensing button opens the LucidShape installer at the License Type Setup screen.
See the appropriate procedure for the license type you want to switch to for details on making changes:

• Nodelocked - step 12 on page 39 in Installing LucidShape with a Nodelocked License on page 37

• Network (Client Installation) - step 12 on page 42 in Installing LucidShape Network (Client
Installation) on page 40

• Network (Server Installation) - step 12 on page 47 in Installing LucidShape Network (Server)
on page 45

4. If you are using LucidShape CAA, you may be able to change the available modules.

See Optional: Specifying Module Licenses to Activate (LucidShape CAA Only) on page 18 for more
details.

5. You may need to restart the LucidShape product for your changes to take effect.

Administering Licenses
As a Synopsys Common Licensing administrator, you can configure and control how licenses are
distributed in your organization.

A single LucidShape license may contain multiple sessions. For example, you may have a session of
LucidDrive and a session of LucidDriveManual running on the same computer at the same time. A single
LucidDriveManual license allows for these multiple sessions.

Synopsys Common Licensing offers tools to enable you to fine tune how your licenses and sessions are
distributed using Options files.

For more information about using Options Files see "Using an Options File" in the Synopsys Common
Licensing Administration Guide.

For nodelocked and Synopsys Common Licensing server installations, the LucidShape installer installs
the Synopsys Common Licensing documentation in C:\Synopsys\SCL\version\doc. The
documentation is also available on SolvNetPlus.
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Using SolvNetPlus to Obtain LucidShape Software and Licenses

Software and license keys for the LucidShape family of products are available for download from the
Synopsys SolvNetPlus website. This appendix describes how to use the website to download these
software products and the license keys required to use them.

Note:  For customers working with distributors, please contact your local LucidShape software
distributor to obtain your software and license. See the Synopsys Optical Solutions Group Global
Contacts (https://optics.synopsys.com/support/support-global-contacts.html) page for contact
information.

Although the examples in this document show and refer to the LucidShape product, the instructions apply
to the entire LucidShape family of products, which includes:

• LucidShape

• LucidDrive

• LucidShape CAA V5 Based

Special terms used in these instructions are explained in the Glossary on page 75.

The process is described in the following procedures:

1. Signing Up for a SolvNetPlus Account on page 52

2. Downloading LucidShape Software from SolvNetPlus on page 52

or

Ordering Media (CDs/DVDs) on page 55

3. Installing LucidShape on page 57

4. Retrieving License Keys on page 58

In this section:

Signing Up for a SolvNetPlus Account on page 52
Before you can download LucidShape software and license keys, you must sign up for a Synopsys
SolvNetPlus account.

Downloading LucidShape Software from SolvNetPlus on page 52
Follow these steps to download any of the software products in the LucidShape family of products.

Ordering Media (CDs/DVDs) on page 55
If you unable to download software and would like to order media (CD or DVD) instead, you can do
this directly on the Synopsys SolvNetPlus website.

Installing LucidShape on page 57
Instructions for installing LucidShape products and license keys are provided in the following chapters:
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Obtaining the Host ID on page 58
A license key is designed to work for only one Host ID, so the license key is associated with a unique
value called a Host ID. Because of this, you need to know the Host ID for the machine or license
dongle before you can retrieve a license key.

Retrieving License Keys on page 58
A license key is a file containing licensing information for your specific USB dongle. You can obtain
license keys using the SmartKeys web page on the Synopsys SolvNetPlus website.

Signing Up for a SolvNetPlus Account
Before you can download LucidShape software and license keys, you must sign up for a Synopsys
SolvNetPlus account.

If you already have a SolvNetPlus account, you can skip to Downloading LucidShape Software from
SolvNetPlus on page 52.

During the registration process, you also need to enter your company’s Site ID. If you do not know your
company’s Site ID, please contact solvnetplusfeedback@synopsys.com to request it. Be sure to include
your company name and address in the email request.

1. Go to https://solvnetplus.synopsys.com and click REGISTER - CREATE ACCOUNT.

2. Follow the instructions for SolvNetPlus Self Registration.

SolvNetPlus will send a verification code to the email address you specified. You must retrieve the
code and enter it on the SolvNetPlus site to complete your registration.

Downloading LucidShape Software from SolvNetPlus
Follow these steps to download any of the software products in the LucidShape family of products.

Installation Guide for LucidShape Products 2023.03 • 52

mailto:solvnetplusfeedback@synopsys.com
https://solvnetplus.synopsys.com


Using SolvNetPlus to Obtain LucidShape Software and Licenses

If you unable to download software, you can order a CD or DVD instead. See Ordering Media (CDs/
DVDs) on page 55 for instructions.

1. Go to https://solvnetplus.synopsys.com and enter your User Name and Password to sign in.

2. Click Downloads .

All Synopsys products currently licensed at your company will be listed.

3. Select the product you want to download.

4. Select the version you would like to download.

The Download Details page is displayed, shown in the following figure.
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5. Under Release Alerts, click the Sign up link to display Release Alerts options that allow you to
subscribe to Release Notification emails from SolvNetPlus. These emails let you know when a new
version of LucidShape is available for download.

a) Click the product name for which you would like to receive notifications or click ALL to receive
notifications for all products in the list.

b) Click the Add button.

c) Click the Include patch notifications check box. This allows you to receive notifications of
LucidShape service releases.

d) Click the Update button.

You are returned to the Download Details page.
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6. On the Download Details page, click Download Here.

7. On the Notice page, click Agree and Sign In to continue.

8. From the list of available files, click the name of the file and then use your browser to open or save the
file.

The following figure shows a list of files for LucidShape version 2019.09.

• checksum_info.txt is a file used for internal purposes.

• FloatingLM.exe is for floating license customers. Only the system administrator who will set up a
floating license server needs to download this file. See Installing and Managing the OSG Floating
License Manager (Legacy Licensing) on page 19 for installation instructions.

• README_LucidShape_2019.09.txt provides a summary of key features in the release.

• SetupLucidShape_2019.09.exe is the installation file for LucidShape.

Ordering Media (CDs/DVDs)
If you unable to download software and would like to order media (CD or DVD) instead, you can do this
directly on the Synopsys SolvNetPlus website.

Follow these steps to order media.

1. Go to https://solvnetplus.synopsys.com and enter your User Name and Password to sign in.

2. Click Downloads.

3. Click the MEDIACENTER link.
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4. On the Media Center page, select the product (e.g., LucidShape , LucidDrive, etc.) and click the Add
button.

5. Complete the Shipping Address information and click Continue.

6. Review the shipping request, shown in the following figure, and click Place Order.

Installation Guide for LucidShape Products 2023.03 • 56



Using SolvNetPlus to Obtain LucidShape Software and Licenses

Installing LucidShape
Instructions for installing LucidShape products and license keys are provided in the following chapters:

• Getting Started on page 5 - lists LucidShape system requirements and tells you how to contact
LucidShape Support.

• Installing LucidShape with Legacy Licensing on page 10 - Install LucidShape on a client system and
configure the license.

• Installing and Managing the OSG Floating License Manager (Legacy Licensing) on page 19 - If you
are using a floating license, you install the license dongle and license key on a network server. You also
install the OSG Floating License Manager on the network server to manage the licenses.

• Installing LucidShape with Synopsys Common Licensing on page 37 - Install LucidShape on a client
system and configure the license.

• Installing and Managing the Synopsys Common Licensing Server on page 44 - If you are using
a network license, you install the license key on a network server. You also install the Synopsys
Common Licensing server on the network server to manage the licenses.

After you install the LucidShape product, continue with Obtaining the Host ID on page 58.
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Obtaining the Host ID
A license key is designed to work for only one Host ID, so the license key is associated with a unique value
called a Host ID. Because of this, you need to know the Host ID for the machine or license dongle before
you can retrieve a license key.

For Legacy Licensing, a USB dongle is required and the Host ID is associated with the dongle. The Host
ID is printed on a label on the USB dongle; if you’re unable to read the ID on the label, you can also obtain
the Host ID by running a program that reads it from the dongle.

For Legacy Licensing; the GetHostID utility is provided for this purpose. See the following steps to run the
GetHostID utility.

• If you’re installing a fixed license: Obtaining the Host ID for a License Dongle on page 13

• If you’re installing a floating license: Obtaining the Host ID for a License Dongle on page 25

For Synopsys Common Licensing, the lmhostid utility is provided for this purpose.

• To retrieve the Host ID for a machine, see Obtaining the Host ID for a Synopsys Common Licensing
Installation on page 48.

• To retrieve the Host ID for a USB Dongle, see Obtaining the Host ID for a Dongle for a Synopsys
Common Licensing Installation on page 49.

After you obtain the Host ID, continue with Retrieving License Keys on page 58.

Retrieving License Keys
A license key is a file containing licensing information for your specific USB dongle. You can obtain
license keys using the SmartKeys web page on the Synopsys SolvNetPlus website.

Follow these steps to obtain your license keys.

1. On the SolvNetPlus home page, click Downloads and then click the SmartKeys tab.

2. On the SolvNetPlus SmartKeys Home page, click the Key Retrieval link.

The SmartKeys Key Retrieval page is displayed.
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You can retrieve a license key for a single USB dongle, or you can retrieve license keys for all Host
IDs at your company.

3. To obtain a license key for a single USB dongle, enter the Host ID of your LucidShape USB dongle in
the Host ID (Optional) field. If you do not know the Host ID value for your USB dongle, see Obtaining
the Host ID on page 58.

To obtain license keys for all products and all Host IDs at your company, leave the Host ID (Optional)
field blank and go on to step 4 on page 59.

4. Click Retrieve Key, shown in the following figure.

Your LucidShape license key will be delivered as a text file attached to an email from the SmartKeys
system. If you did not enter a Host ID in step 3 on page 59, you will receive a separate email with
a single license key attached for each Host ID at your company. The email will include the Host ID for
which the license key is valid.

5. Save the license key to a convenient location on your computer. You need to access this file to activate
LucidShape.

6. See one of the following procedures for instructions on installing the license key to activate your
LucidShape product.

• Installing a License Key for a Fixed License on page 14

• Installing a License Key for a Floating License on page 26

• Installing LucidShape with a Nodelocked License on page 37

• Installing LucidShape Network (Server) on page 45
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Appendix B Troubleshooting the Floating License
Installation (Legacy Licensing)
Troubleshooting the Floating License Installation (Legacy Licensing)

If a security problem occurs when you use a LucidShape floating license, a dialog box displays an error
message. Below are a few common security errors with their causes and resolutions. If you are unable to
correct the problem, contact a LucidShape representative at lucidshape_support@synopsys.com.

In this section:

Problems Installing the License Key Using the Floating License Installer on page 60
Problems Starting LucidShape on page 61

Problems Installing the License Key Using the Floating License Installer

In this section:

Invalid Locking Code on page 60
Sentinel Error on page 61

Invalid Locking Code

Problem

Invalid locking code. Check dongle.

Cause

This could indicate any of the following:

• the license dongle has not been inserted in the USB port

• the USB port is not active

• the Dongle ID in the license file does not match the ID of the inserted Dongle

• the dongle is not valid

Solution

Restart the Sentinel RMS License Manager service. To do this, select Start > Control Panel, click
Administrative Tools and then double-click Services. Locate and right-click Sentinel in the dialog box,
and select the Restart option on the pop-up menu. Then, insert a valid license dongle in an active USB
port (a light glows at the end of the dongle when it’s inserted correctly in an active USB port) and repeat
the steps for installing the license key. (See Installing a License Key for a Floating License on page 26 for
instructions).
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Sentinel Error

Problem

Sentinel: Error [19]: Failed to add license code …

Cause

This general error message indicates that the license key was not applied successfully in the license
manager. This can occur if the file containing the license keys has been corrupted or if license keys that
have already been successfully entered are entered a second time.

Solution

Verify that the license key file contains license keys for the version of LucidShape being installed, and not
for an earlier version; the version number is listed in the comments of the license key file. Also, verify that
the license key file has not become corrupted, which could occur if the license key file has been edited (i.e.,
lines containing license keys are changed or become line wrapped incorrectly).

Problems Starting LucidShape

In this section:

Error 18b on page 61
Error 0xC800100D on page 61
Error 8001008 on page 62

Error 18b

Problem

Error #18b - No valid license code for version x.x.x found.

Cause

Valid license keys have not been entered for this version of LucidShape.

Solution

See Installing a License Key for a Fixed License on page 14 for instructions on installing license keys.

Error 0xC800100D

Problem

Error #0xC800100D - License code for LucidShape version x.x.x has expired.

Cause

The license keys for LucidShape have expired, or the PC date is before the start date of the license.
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Solution

Verify that the date on the computer is correct. Install the license keys for this version of LucidShape on
the license sever machine according to the instructions in Installing a License Key for a Floating License
on page 26. If new license keys are needed, contact your local distributor or a LucidShape representative at
lucidshape_support@synopsys.com.

Error 8001008

Problem

Error #8001008 - License manager is not responding. Verify license manager host is available and license
manager process is running.

Cause

The Floating License Manager program has been disabled.

Solution

Restart the license manager program. To do this, select Start > Control Panel, click Administrative Tools
and then double-click Services. Locate and right-click Sentinel in the dialog box, and select the Restart
option on the pop-up menu.

Cause

The license manager machine is unavailable.

Solution

Verify that the license manager machine is available on the network.

Cause

The name of the license server machine has not been correctly specified.

Solution

In order for LucidShape to use a floating license, you must specify the name of the license server machine
in an initialization file on the client machine (i.e., the machine on which LucidShape is installed). For
instructions on specifying the license server machine to enable your floating license, see Administering
Floating Licenses on page 28.
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V5 Based Installation
Troubleshooting the LucidShape CAA V5 Based Installation

See the following topics for troubleshooting information if you have a problem with LucidShape CAA or
the Light Guide Design Module.

In this section:

Problems Associating LucidShape CAA with the Appropriate CATIA Installation on page 63
You may run into configuration issues when you install LucidShape CAA V5 Based installations
if CATIA is not installed on the same computer or if CATIA is managed by a third-party tool that
maintains configurations and versions.

Specifying Global Settings for NVIDIA Graphics Card on page 65
If you are using an NVIDIA graphics card, its essential to set the Global settings as described in the
following steps. These settings are required by the CATIA V5 environment in order to run LucidShape
CAA V5 Based software.

Troubleshooting the Light Guide Design Module on page 66
See the following topics if you have a problem running the Light Guide Design Module.

Problems Associating LucidShape CAA with the Appropriate CATIA
Installation

You may run into configuration issues when you install LucidShape CAA V5 Based installations if
CATIA is not installed on the same computer or if CATIA is managed by a third-party tool that maintains
configurations and versions.

The following steps are recommended if you encounter problems associating your LucidShape CAA
installation with the appropriate CATIA installation.

In this section:

Choose the CATIA Installation Directory in the Setup Wizard on page 64
During the installation process, you are prompted to choose the installation folder with which to
associate the LucidShape CAA product. If a CATIA installation folder was detected, the path to that
folder is displayed in the input field; however, if CATIA is not installed on the same computer, or if
CATIA is managed by a third-party tool that maintains configurations and versions, the input field may
be blank.

Manually Create a New CATIA Environment on page 64
If LucidShape CAA is not correctly associated with the CATIA after using the LucidShape Setup
wizard, you may need contact the CATIA administrator in your IT department to manually add
LucidShape CAA to a different environment, as described in the following steps.
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Choose the CATIA Installation Directory in the Setup Wizard
During the installation process, you are prompted to choose the installation folder with which to associate
the LucidShape CAA product. If a CATIA installation folder was detected, the path to that folder is
displayed in the input field; however, if CATIA is not installed on the same computer, or if CATIA is
managed by a third-party tool that maintains configurations and versions, the input field may be blank.

Edit the path or click the Browse button to navigate to the appropriate directory and select it; then,
complete the installation instructions. If LucidShape CAA is not correctly associated with CATIA, see
Manually Create a New CATIA Environment on page 64.

Manually Create a New CATIA Environment
If LucidShape CAA is not correctly associated with the CATIA after using the LucidShape Setup wizard,
you may need contact the CATIA administrator in your IT department to manually add LucidShape CAA
to a different environment, as described in the following steps.

1. To open the CATIA Environment Editor, click the Windows Start button and select CATIA >
Environment Editor [version].

2. In the Environment Editor, select Environment > New.

3. In the New Environment dialog box, append the LucidShape CAA installation path to the Install Path
and click OK.
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If these steps do not resolve the issue, contact LucidShape CAA support at
lucidshape_support@synopsys.com.

Specifying Global Settings for NVIDIA Graphics Card
If you are using an NVIDIA graphics card, its essential to set the Global settings as described in the
following steps. These settings are required by the CATIA V5 environment in order to run LucidShape
CAA V5 Based software.

1. Right-click on your desktop and select NVIDIA Control Panel.

2. Select 3D Settings > Manage 3D Settings on the left under Select a Task, shown in the following
figure.
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3. On the Global Settings tab, set the Global presets to Dassault Systemes - V5 and set the Preferred
graphics processor to High-performance NVIDIA processor, as shown in the following figure.

If you have only one graphics processor available, the Preferred graphics processor option is not
displayed.

4. Click Apply.

Troubleshooting the Light Guide Design Module
See the following topics if you have a problem running the Light Guide Design Module.

In this section:

Verify That the Light Guide Design Module is Linked with LucidShape CAA on page 67
In some situations, the LucidShape CAA V5 Based product appears to have installed successfully, but
you may not able to use the Light Guide Design Module; for example, you may be able to start the
Light Guide Design Module but not be able to create a spline curve to start the design process. This
may indicate that the Light Guide Design Module is not linked properly with LucidShape CAA.

Set CATIA Option to Preserve Object Naming for the Light Guide Design Module on page 67
Depending on the CATIA Options settings, CATIA may rename objects created by the Light Guide
Design Module to avoid having duplicate names in the Specification Tree. When this happens, the
Light Guide Design Module can no longer identify those objects or continue to perform operations.
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Verify That the Light Guide Design Module is Linked with LucidShape CAA
In some situations, the LucidShape CAA V5 Based product appears to have installed successfully, but you
may not able to use the Light Guide Design Module; for example, you may be able to start the Light Guide
Design Module but not be able to create a spline curve to start the design process. This may indicate that
the Light Guide Design Module is not linked properly with LucidShape CAA.

To fix this, run the file SetupEnvironment.bat located in the LucidShape CAA installation folder (e.g., C:
\Program Files\Synopsys\LucidShapeCAA\R32\2022.06-1 ).

If this does not fix the problem, you may not have adequate privileges to automatically perform all
the steps needed to properly enable licensing. (Administrator privileges can vary, depending on the
configuration for your Windows operating system.) To work around this problem, you can manually run
one of the license tools as administrator, as described in the following steps.

1. Close LucidShape CAA and any windows of the Light Guide Design Module.

2. In Windows Explorer, navigate to the LucidShape CAA V5 Based installation directory on your hard
drive and open the sub-folder LicenseTools.

3. Right-click the file lsinit.exe and select Run as administrator on the shortcut menu.

4. Restart LucidShape CAA and the Light Guide Design Module.

If the problem is not resolved, contact LucidShape CAA support at lucidshape_support@synopsys.com.

Set CATIA Option to Preserve Object Naming for the Light Guide Design Module
Depending on the CATIA Options settings, CATIA may rename objects created by the Light Guide Design
Module to avoid having duplicate names in the Specification Tree. When this happens, the Light Guide
Design Module can no longer identify those objects or continue to perform operations.

To circumvent this problem, set the CATIA renaming option as described in the following steps.

1. Select the CATIA menu Tools > Options.

2. Expand the Infrastructure heading in the Options tree on the left and select Part Infrastructure.

3. Select the Display tab.

4. Under the heading Checking Operation When Renaming, make sure that No name check is selected,
as shown in the following figure.
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5. Click OK.

6. Restart LucidShape CAA for the change to take effect.

Note:  The Light Guide Design Module automatically checks the No Name Check option and
displays the following warning if it has not been activated.

Installation Guide for LucidShape Products 2023.03 • 68



Appendix D Troubleshooting Synopsys Common
Licensing
Troubleshooting Synopsys Common Licensing

This appendix lists licensing errors that you might encounter with Synopsys Common Licensing and
describes probable causes and resolutions.

If you are unable to correct the problem, please contact LucidShape Customer Support (see Contacting
LucidShape Customer Support on page 9).

This version of the LucidShape installer includes the following components for Synopsys Common
Licensing:

• Photonics Solutions Synopsys Common Licensing components version 2023.03

• Synopsys Common Licensing version 2022.12

For nodelocked or Synopsys Common Licensing server installations, the LucidShape installer configures
the Synopsys Common Licensing server as the Flexlm Service 1 service.

Error messages may refer to the "flex log", which is the log file for Synopsys Common Licensing.
The LucidShape installer configures this log file to be named flexlog.txt in the C:\Synopsys
\PhotonicSolutions\2023.03\RSoft\licenses directory.

Synopsys Common Licensing always includes a Synopsys Common Licensing server. Even when you have
a nodelocked installation, there is an instance of the Synopsys Common Licensing server running on your
system. Therefore, even when you are not using a networked license, you may have issues communicating
with the Synopsys Common Licensing server.

In this section:

There are no remaining licenses for the requested feature on page 70

The license does not include the requested feature on page 70

Cannot connect to the license server system on page 70
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A connection to the Synopsys Common Licensing license manager was lost on page 72

The license request was denied by the network license server on page 72

Time Tamper Error on page 73

LucidShape cannot find the Synopsys licensing service/daemon (snpslmd) on page 73

Uninstall Synopsys Common Licensing on page 73

There are no remaining licenses for the requested feature

Problem

Licensed number of users already reached.

Cause

A limited number of users can use this feature at the same time, and the limit has been reached.

Solution

If you are running multiple sessions concurrently, you may have reached the maximum concurrent session
limit.

For network licenses, please wait for other users to end their feature usage, then try again.

To further check license usage at your site, please contact your Synopsys Common Licensing license
administrator.

The license does not include the requested feature

Problem

No Such Feature Exists

Cause

The license file found does not contain a valid feature for this version of the software.

Solution

Please check with your LucidShape administrator for the valid features.

Cannot connect to the license server system

Problem

The license for module LucidShape is not available. LucidShape cannot run due to a licensing issue.
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Cause

The license server manager (lmgrd) has not been started yet, the wrong port@host or license file is being
used, or the port or hostname in the license file has been changed.

(lmgrd) daemon is not running.

Solution

The LucidShape installer configures this as the Flexlm Service 1 service. Confirm the Flexlm Service 1 is
running on your system (nodelocked) or the Synopsys Common Licensing server system (network). If you
cannot find the Flexlm Service 1 service, try the following:

• Reboot the system.

• Configure your licensing again. See Modifying License Options on page 50 to reconfigure the selected
license type.

• Contact LucidShape Customer Support.

For nodelocked licenses, there are situations where the licensing processes can be stopped and will not
automatically restart. When you try to start the software you will get the Cannot connect to the
license server system error. Under these circumstances you will need to restart your computer to
get the licensing processes to restart.

Cause

Wrong port/host or license is being used.

Solution

See Modifying License Options on page 50 to update the host name and port number for the license server

Cause

License file is expired.

Solution

If your license agreement is current, you can request an updated license from SolvNetPlus or from
LucidShape Customer Support.

If you need to renew your license agreement, please contact optics@synopsys.com or your local
distributor.

Cause

License file contains an invalid Host ID.

Solution

Contact LucidShape Customer Support.

Cause

License file is not installed.
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Solution

See Modifying License Options on page 50 to update the license file.

A connection to the Synopsys Common Licensing license manager was
lost

Problem

The complete error message is A connection to the Synopsys Common Licensing
license manager was lost, and the application has exhausted all of its
retry attempts.

Cause

Cannot connect to license server system.

Solution

For network licenses, check your network connection to your network license server.

If the error persists, contact LucidShape Customer Support or your local distributor.

Include the following:

• A screenshot of the License Manager Error window

• The following files from the licenses folder (by default, C:\Synopsys
\PhotonicSolutions\2023.03\RSoft\licenses):

• rsoft.lic

• flexlog.txt

The license request was denied by the network license server

Problem

This error message can be received from multiple scenarios.

• The User/Host on EXCLUDE list for feature (FlexNet Licensing error: -38, -101)

• User/host not on INCLUDE list for feature (FlexNet Licensing error: -39)

• Checkout exceeds MAX specified in options file (FlexNet Licensing error: -87)

Cause

This error can occur for one of the following reasons:

• Max limit of users has been reached.

• You have been excluded from using this feature.

• The feature is reserved for others.
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Solution

Please contact your Synopsys Common Licensing administrator.

Time Tamper Error

Problem

A problem with the system clock has been detected.

Cause

This error may indicate that the system clock is currently set incorrectly, or has been set incorrectly in the
past.

Solution

Contact lucidshape_support@synopsys.com or your local distributor and provide a copy of the error
message, including the Host ID mentioned in the error message.

LucidShape cannot find the Synopsys licensing service/daemon (snpslmd)

Problem

The Synopsys licensing service/daemon (snpslmd) is either down, or inaccessible.

Cause

The Synopsys licensing service/daemon can terminate because of the following reasons:

• All the features are expired for this version of the software.

• The license file is corrupted.

• The license file contains an invalid server Host ID.

Solution

If you are using a network license your connection with the computer hosting the license service/daemon
may have been interrupted. Please check your network connection.

Firewall(s) must be configured to allow the Synopsys Common Licensing server (lmgrd.exe and
snpslmd.exe) to communicate on ports 27020 and 27021. If you get an error such as a -96 FlexNet
Licensing error, make sure both ports are open in any firewalls.

If you are using a nodelocked license, confirm that the Flexlm License 1 service is running.

Uninstall Synopsys Common Licensing

CAUTION:  Do not remove the Synopsys Common Licensing server unless you have confirmed
no Synopsys products are using the Synopsys Common Licensing server instance.
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If instructed by LucidShape Customer Support, you can remove the Synopsys Common Licensing
components from a system.

The LucidShape installer automates the installation and configuration of the Synopsys Common Licensing
components. However, the installer treats these components as separate installations and they are not
included when you run the LucidShape Uninstall tool.

Follow these instructions to remove the Synopsys Common Licensing components.

1. Log in to your system as an administrator.

2. Open Add and Remove Programs.

3. Uninstall Optical/Photonic Solutions Licensing.

4. Uninstall SCL Version.

5. Restart the system.

6. (Optional) Delete the C:\Synopsys folder only if you have no other Synopsys applications using
that folder.
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Client (machine)
The client, or client machine, is a computer that has LucidShape installed on it, and is configured to request
a license from a license server. For LucidShape Legacy Licensing, this machine runs software that uses a
floating license. For Synopsys Common Licensing, this machine runs Network Client software, which uses
a network license.

Fixed License
Used with Legacy Licensing. A license associated with a specific USB dongle.

Floating License
Used with Legacy Licensing. A license managed by the OSG Floating License Manager.

Host ID
A unique ID used to associate a license with a specific computer.

For Legacy Licensing, this is a hexadecimal value encoded on the USB dongle.

For Synopsys Common Licensing, this is a value retrieved using the lmhostID Utility. The value may be
associated with your computer or with a USB dongle.

The Synopsys SmartKeys site and delivery email reference the Host ID value when license keys are
requested and delivered.

Note:  The Host ID is unique for each method of licensing and is not interchangeable.

Legacy Licensing
The method of licensing used in releases up to and including LucidShape 2023.03. It is based on the
Sentinel License Manager

License Key File
A file containing the encoded license information needed to run LucidShape products for a specific
computer or USB dongle.

Note:  The license key is unique for each method of licensing and is not interchangeable.

Network License
Used with Synopsys Common Licensing. A license managed by the Synopsys Common Licensing server.
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Nodelocked License
Used with Synopsys Common Licensing. A license associated with a specific computer. It may also require
a USB dongle.

Site ID
A unique number used to identify a specific company. Every company that uses LucidShape products and
other Synopsys software has a unique site ID.

SmartKeys
The SolvNetPlus page where you submit license key requests.

SolvNetPlus
The Synopsys customer portal (https://solvnetplus.synopsys.com). This is where you go to download
LucidShape product software as well as license keys.

See https://solvnetplus.synopsys.com/s/article/LucidShape-Products-Support on SolvNetPlus to get started
with Knowledge Articles, Tech Talks, Training, and much more for LucidShape.

Synopsys Common Licensing
The license management tool used by Synopsys. This method of licensing LucidShape is available starting
with LucidShape version 2023.03. It is based on FlexNet Licensing.
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